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Introduction 

 
In SCIA Engineer there is the possibility to use the XML format to get the data of the Project the users 
are working on. In the first chapters of this tutorial the different features of the format will be presented 
in detailed and the XML import/export option explained. 
 
The XML output can be adopted for several uses. The example here presented is to create VBA in Excel 
which modifies certain parameters of the XML file and allows to update these properties in the model. 
 
Connected to this format the application ESA_XML.exe has been developed. 
It is a powerful technology that allows run SCIA Engineer in the background, and by consequence to run 
calculations and export results. 
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Part 1: Import/Export of the XML format 

 

1.1 Creating the model 

Input of geometry 

Create the following structure in SCIA Engineer. 
 

 

Sections 

Columns              Rafters 
 

    
 

Note: The use of parametric sections will allow us to influence one of the section parameter to obtain different values. 
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Loads 

G: Self weight 
Q: Variable > line force on roof beams 4 kN/m in Z direction (GCS) 

Load Combinations 

CO1: EN-ULS Set B 
CO2: EN-SLS Characteristic 

1.2 Export structure data to XML 

 
After creating the load cases and load combinations and applying these on the structure we can create the 
XML-file. 
This can be done via Tools > XML IO Document 
It will ask you to load a template. SCIA Engineer has some standard templates in which you can choose from. 
In this case we click on cancel in order to not use a template but to create a new XML-file from scratch. 

 
 

We click on new to start adding items in your XML-file 

 
 

The order of the added items is very important in an XML-file because the XML-file will be read from top to 
bottom. For example, you cannot define a load case before defining the load groups because the load group 
is a property of the load case. This can result in errors when using the XML-file. Another example is that you 
cannot input a beam without prior inputting the cross-section and the nodes because these are properties of 
that beam. Always keep the logical order in mind so that you obtain a working XML-file which can be used in 
SCIA Engineer. 
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We add to the Document all the data of the structure we have created. Every element added will be shown on 
the right side of the Screen in the preview.  The document should then contain the structural elements 
(supports, columns, beams) as well as the load cases, load combinations, applied loads. 
 
The below picture should be the end result. 

 
 
In the properties shown in the bottom part we can change only the text shown in the Preview. 
To amend the tables, we can select them and click on Table Composer as for the following image. 

 
 
All the data shown in the Table Composer can be added to our Document and exported in the XML document 
and then used externally. 
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We export then the XML document. Before exporting this data to XML make sure that the content is fully 
regenerated. 
 

 
 
We click on export and navigate to the folder in which you want to export this data to XML. 
For the XML document the Unicode Standard needs to be used. It is selected by default. 
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Part 2: Reading the XML file 

 

2.1 The DEF file 

 
Once we have exported the document in XML, we notice two files have been created, a XML document and a 
file DEF. The file DEF contains the list of all the parameters of the tables we have exported. The XML document 
contains all the information of the particular Project we are modelling, so the XML document refers to the DEF 
file to read all the different possibilities and indicate the ones chosen in the project created. 
 
We open the generated DEF file using Notepad (txt reader).  
 

 
We can see at the top the information related to the xml version, the standard used (Unicode) and the type of 
Protection (Standalone) 

Containers 

In order to read both XML document and DEF file, we can orientate with the different “Containers”. Each 
container is one of the tables added in the Document created in SCIA.  
 
The first one is in fact Project and contains all the parameters we chose when starting a new project. We can 
see them defined as def_properties. If we read all the DEF file, we can see then Materials, Sections, etc., in 
which all the general information are reported.  
 

2.2 The XML document 

 
We open the generated XML document using Notepad (txt reader) or the Browser Explorer (Html format). 
 
Let’s focus on the third Container: Cross Sections. As shown in the image below the DEF File (on the right) 
contains the general information to define a cross section and the XML file (on the left) contains the information 
related to the project we have defined.  
 
In our case the properties Name, Catalog ID, Catalog Item and Parameters are recalled from the DEF File and 
defined as: 
 

- Name: CS1, in the DEF file is defined as string, so a word.  

- Catalog ID: ThinWalled Section (in the DEF file is defined as string, the library path has been recalled), 

- Catalog Item: I section (in the DEF file is defined as integer. As it is the first one of the catalog, the 
number 0 has been assigned) 

- Parameters: in the DEF file a table is defined with 9 parameters.  
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For the forth property, number 3, a subtable has been defined and 9 possible parameters can be recalled.  
 
In this case, in the project only 3 of these are defined: Name, Material and Length.  
In the first row, number 0, the name is Material, and the material is defined; in the other rows, number 1-2-3-
4-5, the name is one of the parameters of the section, and a value (Length) is defined for each one of the 
properties. 
 
 

 
 
 
We know now how to read the XML document, so we are able to modify it in order to obtain the desired results.  
 
In this paragraph we show how to amend the XML document manually. In the next chapter we will use instead 
a Macro created in Excel in order to modify more parameters automatically.  
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Modify the XML document 

In this case for example we want to modify the height of the rafter and update our model with this update. 
We copy the XML document and DEF file. We open the copy of the XML document and we modify the height 
of the beam in the appropriate container:  
 

 
 
We save and close the XML document.  

Update the structure with XML 

We update the current project with this XML-file via File > Update > XML-file 

 
 
As the software reads the XML document, the changes are applied. 
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Part 3: Link Excel-XML-SCIA  

3.1 Modify an XML file using Macros in Excel 

 
We will see in this chapter how to create a Macro which gives as output an XML document modified with the 
parameters we have inserted in Excel.  
 
Notes: from this Chapter on, a strong basis of Excel VBA is required. 
 
The Excel sheet will allow us to modify externally the dimensions of the section of the rafters of the project we 
have modelled in the previous chapter.  
 
Let us now start MS EXCEL, create a new document and define two sheets. Let us name them "Table" and 
"XML". The first one (Table) will be our "User interface", i.e. it will be the sheet that will be used by the user. 
The other one (XML) will be used as an auxiliary sheet to hold the contents of the XML file we have to generate. 
 
We open Excel and we create a table with the parameters we want to influence, as for the image below.  
 

 
 
We go now to the second Excel sheet, called “XML”, in which we copy in the second column the XML document 
created before. In this sheet we are going then to add the references for the script we are going to write.  
 
We scroll the script and we position the references H, B, t, s and R as for image below:  
 

 A B 

  […] 

190           <obj id="2" nm="CS2"> 

191 

 

            <p0 v="CS2"/> 

192 

 

            <p1 v="EP_CssLib.EP_ProfLib_GeomThinWalled.1"/> 

193 

 

            <p2 v="0"/> 

194 

 

            <p3 t=""> 

195 

 

            <h> 

196 

 

            <h0 t="Name"/> 

197 

 

            <h1 t="Material"/> 
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198 

 

            <h4 t="Length"/> 

199 

 

            </h> 

200 

 

            <row id="0"> 

201 

 

            <p0 v="Material"/> 

202 

 

            <p1 i="152" n="S 235"/> 

203 

 

            </row> 

204 

 

            <row id="1"> 

205 

 

            <p0 v="H"/> 

206 H             <p4 v="0.29999999999999999"/> 

207 

 

            </row> 

208 

 

            <row id="2"> 

209 

 

            <p0 v="B"/> 

210 B             <p4 v="0.14999999999999999"/> 

211 

 

            </row> 

212 

 

            <row id="3"> 

213 

 

            <p0 v="t"/> 

214 t             <p4 v="0.010699999999999999"/> 

215 

 

            </row> 

216 

 

            <row id="4"> 

217 

 

            <p0 v="s"/> 

218 s             <p4 v="0.0070999999999999995"/> 

219 

 

            </row> 

220 

 

            <row id="5"> 

221 

 

            <p0 v="R"/> 

222 R             <p4 v="0.014999999999999999"/> 

223 

 

            </row> 

224 

 

            </p3></obj> 

225 

 

      </table> 

  […] 

Create the VBA 

We create now the VBA script, which allows us to create a new XML document by clicking on “Recalculate” in 
the first Excel sheet, and which will contain the new values of the dimensions of the cross section “CS2”.  
 
To add the Recalculate command, we go to developer and we add a Command Button (active X control).  
We go to the properties and we can change the name and reference to “Recalculate” 
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We can create our script. The example below can be used (please control and modify the path of the folders 
following their location in the machine): 
 
Private Sub Recalculate_Click() 
' Open XML file for writing' 
Dim fs, f 
Set fs = CreateObject("Scripting.FileSystemObject") 
Set f = fs.CreateTextFile("C:\Users\michele\Desktop\XML_tutorial\XMLex.xml", True, True) 
' we assume that the data are stored in folder C:\Users\michele\Desktop\ XML_tutorial 
' Generate XML file using the two input values 
Dim SomethingToWrite As Boolean 
SomethingToWrite = True 
Dim mystring As String 
Dim i As Integer 
i = 1 
Do 
mystring = Worksheets("XML").Cells(i, 2).Value 
If mystring <> "" Then 
If Worksheets("XML").Cells(i, 1).Value = "H" Then 
' this line stores the value of the diameter' 
mystring = " <p4 v=""" & Str(Worksheets("Table").Cells(5, 2).Value / 1000) & """/>" 
End If 
If Worksheets("XML").Cells(i, 1).Value = "B" Then 
' this line storesthe value of the thickness' 
mystring = " <p4 v=""" & Str(Worksheets("Table").Cells(6, 2).Value / 1000) & """/>" 
End If 
If Worksheets("XML").Cells(i, 1).Value = "t" Then 
' this line storesthe value of the thickness' 
mystring = " <p4 v=""" & Str(Worksheets("Table").Cells(7, 2).Value / 1000) & """/>" 
End If 
If Worksheets("XML").Cells(i, 1).Value = "s" Then 
' this line storesthe value of the thickness' 
mystring = " <p4 v=""" & Str(Worksheets("Table").Cells(8, 2).Value / 1000) & """/>" 
End If 
If Worksheets("XML").Cells(i, 1).Value = "R" Then 
' this line storesthe value of the thickness' 
mystring = " <p4 v=""" & Str(Worksheets("Table").Cells(9, 2).Value / 1000) & """/>" 
End If 
f.WriteLine (mystring) 
i = i + 1 
Else 
SomethingToWrite = False 
End If 
Loop While SomethingToWrite = True 
f.Close 
End Sub 
 
The VBA script will create a file XML, in the folder in which we have saved the DEF file, with the new dimensions 
of the section of the rafters, which overwrite the one of the script before.  
We can open and check the new XML file created.  
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Update the structure with XML 

We update the current project with this XML-file via File > Update > XML-file 
 

 
 
As the software reads the XML document, the changes are applied. 
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Part 4: Running a calculation 

 

4.1 the esa_XML.exe application 

In order to run SCIA in the background, the application esa_XML has been created. It is executable from 
another program, that is capable of using XML file to modify ESA project data and obtain outputs in various 
formats. 
It is a command line program and is able to perform the following tasks. 

• open the existing ESA project 

• read the given XML format and use its data to override the project 

• perform the given type of calculation 

• regenerate the existing document in the ESA project and export it into the selected format 
(HTML,TXT,ESA). In case of several documents, one can specify the name of the document, 
otherwise the current document is used. 

• regenerate the existing output XML format and use it to generate XML file. If there are more than one 
output formats in the project, it is possible to select the format by name. 

 

Command line parameters of esa_XML 

Calculation type : 
   NONE = without any recalculations 
   NOC = No calculation 
   LIN = Linear calculation (Delete all calculated results when exists) 
   NEL = Nonlinear calculation 
   CON = Nonlinear concrete calculation 
   EIG = Eigen frequencies calculation 
   STB = Stability calculation 
   INF = Influence lines calculation 
   MOB = Mobile loads calculation 
   TDA = TDA calculation 
   SLN = Soilin calculation 
   PHA = Phases calculation 
   NPH = Nonlinear phases 
   CSS = Recalculation of cross sections 
   NST = Nonlinear stability 
   TID = Test of input data - solver link only 
 
If text CMD is input, it is possible to perform arbitrary number of actions within one run of the 
program. 
 
The second parameter is the name of text file, where each line has the same syntax as the whole program 
and leads to opening of one file (sub-levels are not allowed in CMD). 
- input ESA project (file name including path) 
- input XML file (file name including path) – optional parameter 
 
Third parameter: Switches – starting with ‘/’ or ‘-‘ character 
 
/t – output file type – TXT, HTML,ESA 
if not stated, the output file type is set to ESA 
/l – log file name 
/o – output file name, the extension must be specified by used according to the selected output file type 
if not stated, no output is performed 
/x – name of output XML file 
if not stated, no output is performed 
/d – name of document from which the output is performed, if not stated, the current document is used 
/m – name of output XML format, if not stated, the current one is used 
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4.2 VBA script to run esa_XML 

 
We will prepare a VBA script (run from an XLS sheet) that will perform a calculation of the displacement and 
of the moment My in the rafters. SCIA Engineer as a calculation engine will be running in the background. The 
user won’t even spot it on the screen and will be able to think that the EXCEL sheet itself does everything. 
 
All the results of the project need to be in the Document of the project. We open our esa1.exe file and in the 
Project menu we switch from v17 to v16 in order to activate the Document in the functionality menu.  
 

 
 
We go to document and add the requested results.  
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Then we set for each one of the results the list of elements and the combination we want to export. 
 
For the moment My: 
 

 
 
For the displacement Uz: 
 

 
 
Final document: 
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Then we can start to create our script. The example below can be used (please control and modify the path of 
the folders following their location in the machine):  
 
Private Sub Recalculate_Click() 
' Open XML file for writing' 
Dim fs, f 
Set fs = CreateObject("Scripting.FileSystemObject") 
Set f = fs.CreateTextFile("C:\Users\michele\Desktop\XML_tutorial\XMLex.xml", True) 
' we assume that the data are stored in folder C:\Users\michele\Desktop\ XML_tutorial 
' Generate XML file using the two input values 
Dim SomethingToWrite As Boolean 
SomethingToWrite = True 
Dim mystring As String 
Dim i As Integer 
i = 1 
Do 
mystring = Worksheets("XML").Cells(i, 2).Value 
If mystring <> "" Then 
If Worksheets("XML").Cells(i, 1).Value = "H" Then 
' this line stores the value of the diameter' 
mystring = " <p4 v=""" & Str(Worksheets("Table").Cells(5, 2).Value / 1000) & """/>" 
End If 
If Worksheets("XML").Cells(i, 1).Value = "B" Then 
' this line storesthe value of the thickness' 
mystring = " <p4 v=""" & Str(Worksheets("Table").Cells(6, 2).Value / 1000) & """/>" 
End If 
If Worksheets("XML").Cells(i, 1).Value = "t" Then 
' this line storesthe value of the thickness' 
mystring = " <p4 v=""" & Str(Worksheets("Table").Cells(7, 2).Value / 1000) & """/>" 
End If 
If Worksheets("XML").Cells(i, 1).Value = "s" Then 
' this line storesthe value of the thickness' 
mystring = " <p4 v=""" & Str(Worksheets("Table").Cells(8, 2).Value / 1000) & """/>" 
End If 
If Worksheets("XML").Cells(i, 1).Value = "R" Then 
' this line storesthe value of the thickness' 
mystring = " <p4 v=""" & Str(Worksheets("Table").Cells(9, 2).Value / 1000) & """/>" 
End If 
f.WriteLine (mystring) 
i = i + 1 
Else 
SomethingToWrite = False 
End If 
Loop While SomethingToWrite = True 
f.Close 
Shell "C:\Program Files (x86)\SCIA\Engineer18.1\Esa_XML.exe LIN 
C:\Users\michele\Desktop\XML_tutorial\Esa1.esa C:\Users\michele\Desktop\XML_tutorial\XMLex.xml /tTXT 
/oC:\Users\michele\Desktop\XML_tutorial\Results.xls" 
'Assumptions: 
'SCIA Engineer installed in folder C:\Program Files (x86)\SCIA\Engineer18.1 
' project file stored in folder C:\Users\michele\Desktop\XML_tutorial 
' XML file generated to folder C:\Users\michele\Desktop\XML_tutorial 
'Note: 
'File Esa_XML.exe is an integral part of SCIA Engineer installation 
' Parameters of "SHELL" command 
' C:\Program Files (x86)\SCIA\Engineer18.1\Esa_XML.exe = location of Esa_XML.exe 
' LIN= linear calculation 
' C:\Users\michele\Desktop\XML_tutorial\Esa1.esa = original project file 
' C:\Users\michele\Desktop\XML_tutorial\XMLex.xml = XML file for the update function 
' /tTXT /oC:\Users\michele\Desktop\XML_tutorial\Results.xls = export the document stored inside the project 
file as TXT file with location and name C:\Users\michele\Desktop\XML_tutorial\Results.xls 
Application.Wait (Now + TimeValue("0:00:15")) 
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'wait in order to guarantee that SCIA Engineer completes the calculation before the control of the operation is 
returned to the VBA Script 
'Read result into XLS sheet C:\Users\michele\Desktop\XML_tutorial\Results.xls' 
' Insert the result value into the appropriate cell of the "Table" sheet 
Dim momentcentre As Variant 
Dim momentside As Variant 
Dim deformation As Variant 
Workbooks.Open Filename:="C:\Users\michele\Desktop\XML_tutorial\Results.xls" 
momentcentre = Sheets("Results").Cells(14, 6).Value 
momentside = Sheets("Results").Cells(16, 6).Value 
deformation = Sheets("Results").Cells(36, 4).Value 
'The Cell (14,6) of the "document file" contains the required moment My in the centre 
'The Cell (16,6) of the "document file" contains the required moment My on the side 
'The Cell (36, 4) of the "document file" contains the required vertical displacement 
'to find out this, you have to open the generated XLS file manually (only once) and note down the cell 
coordinates 
Workbooks("Results.xls").Close 
Worksheets("Table").Cells(16, 2).Value = momentcentre 
Worksheets("Table").Cells(17, 2).Value = momentside 
Worksheets("Table").Cells(19, 2).Value = deformation 
End Sub 
 
 
The result will be the following:  
 

 
 
With a click we can check easily check the change in the moments and the displacement Uz.  
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Part 5: Advanced features 

 

5.1 Start command to run Batch analysis 

 
In this chapter we explain how to run calculation with the Start command. This is command run in the Command 
Prompt environment, so we will use the Excel VBA to call this command, which will then run in the background. 
 
The Start command allows us to use the string /WAIT to set the time for the calculation of our application.  

Creation of the application .cmd 

The first step in this case is to create the application (called XMLtutorial.cmd in this case). We open an 
empty txt file and we write for example the following: 
 
START "XMLtutorial" /WAIT "C:\Program Files (x86)\SCIA\Engineer18.1\ESA_XML.exe" LIN 
"C:\Users\michele\Desktop\XML_tutorial\Esa1.esa" "C:\Users\michele\Desktop\XML_tutorial\XMLex.xml" 
/tTXT /o"C:\Users\michele\Desktop\XML_tutorial\Results.xls" 
 
Notes: 

- C:\Program Files (x86)\SCIA\Engineer18.1\Esa_XML.exe = location of Esa_XML.exe 

- C:\Users\michele\Desktop\XML_tutorial\Esa1.esa = original project file 

- XML file generated to folder C:\Users\michele\Desktop\XML_tutorial 

- /tTXT /oC:\Users\michele\Desktop\XML_tutorial\Results.xls = export the document stored inside the 
project file as TXT file with location and name C:\Users\michele\Desktop\XML_tutorial\Results.xls (it 
is an Excel file, it could be also C:\Users\michele\Desktop\XML_tutorial\Results.txt 

 
We save it as XMLtutorial.txt and then we change the format to .cmd . 

First Macro to call the application XMLtutorial.cmd 

The following step is to create a first Macro Command, (which we can call Recalculate as for previous 
example) which script could be the following (please control and modify the path of the folders following their 
location in the machine): 
 
Private Sub Recalculate_Click() 
Dim fs, f 
Set fs = CreateObject("Scripting.FileSystemObject") 
Set f = fs.CreateTextFile("C:\Users\michele\Desktop\XML_tutorial\XMLex.xml", True) 
Dim SomethingToWrite As Boolean 
SomethingToWrite = True 
Dim mystring As String 
Dim i As Integer 
i = 1 
Do 
mystring = Worksheets("XML").Cells(i, 2).Value 
If mystring <> "" Then 
If Worksheets("XML").Cells(i, 1).Value = "H" Then 
mystring = " <p4 v=""" & Str(Worksheets("Table").Cells(5, 2).Value / 1000) & """/>" 
End If 
If Worksheets("XML").Cells(i, 1).Value = "B" Then 
mystring = " <p4 v=""" & Str(Worksheets("Table").Cells(6, 2).Value / 1000) & """/>" 
End If 
If Worksheets("XML").Cells(i, 1).Value = "t" Then 
mystring = " <p4 v=""" & Str(Worksheets("Table").Cells(7, 2).Value / 1000) & """/>" 
End If 
If Worksheets("XML").Cells(i, 1).Value = "s" Then 
mystring = " <p4 v=""" & Str(Worksheets("Table").Cells(8, 2).Value / 1000) & """/>" 
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End If 
If Worksheets("XML").Cells(i, 1).Value = "R" Then 
mystring = " <p4 v=""" & Str(Worksheets("Table").Cells(9, 2).Value / 1000) & """/>" 
End If 
f.WriteLine (mystring) 
i = i + 1 
Else 
SomethingToWrite = False 
End If 
Loop While SomethingToWrite = True 
f.Close 
Shell "C:\Users\michele\Desktop\XML_tutorial\XMLtutorial.cmd"  
End Sub 
 
The command in this case will be run and even if the Command will be ended, in the background the Start 
apllication will continue until the command is complete. 
 
When the command is complete, we will see in the folder C:\Users\michele\Desktop\XML_tutorial the files 
XMLex.xml and Results.xls appear.  

Second Macro to export the Results 

The Second Macro to be created, for example ResultsXML, can have the following script: 
 
Private Sub ResultsXML_Click() 
Dim deformation As Variant 
Dim moment As Variant 
Workbooks.Open Filename:="C:\Users\michele\Desktop\XML_tutorial\Results.xls" 
deformation = Sheets("Results").Cells(36, 4).Value 
moment = Sheets("Results").Cells(15, 6).Value 
Workbooks("Results.xls").Close 
Worksheets("Table").Cells(18, 2).Value = deformation 
Worksheets("Table").Cells(16, 2).Value = moment 
End Sub 
 
In this case, the Results file will be read and the different values reported in the Excel file.  
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This system will allow us to run important calculation without the need to set the correct value of the time 
waiting, as we did in the previous case.  
 
The start command allows us also to run batch calculation: For example, we can write in the .cmd file:  
 
START "XMLtutorial" /WAIT "C:\Program Files (x86)\SCIA\Engineer18.1\ESA_XML.exe" LIN 
"C:\Users\michele\Desktop\XML_tutorial\Esa1.esa" "C:\Users\michele\Desktop\XML_tutorial\XMLex.xml" 
/tTXT /o"C:\Users\michele\Desktop\XML_tutorial\ResultsLIN.xls" 
 
START "XMLtutorial" /WAIT "C:\Program Files (x86)\SCIA\Engineer18.1\ESA_XML.exe" NEL 
"C:\Users\michele\Desktop\XML_tutorial\Esa1.esa" "C:\Users\michele\Desktop\XML_tutorial\XMLex.xml" 
/tTXT /o"C:\Users\michele\Desktop\XML_tutorial\ResultsNEL.xls" 
 
 
This will run both calculation and export the results in two different files.  
 

5.2 Complete the Excel sheet with the profile’s library 

 
We complete now our spreadsheet by coping a Profile’s Library of IPE in the Excel sheet. We can then 
create a drop-down list with the profile and connect directly all the dimensions to the profile selected.  
 

 
 
Now once we chose a profile, all the dimensions will be automatically updated in the Spreadsheet.  
We chose for example an IPE400: we run “Recalculate” and “ResultsXML” and we get the final result.  
 

 


